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1. Introduction 
HEAT tickets, also referred to as call records, provide a complete record of a 
problem, service request, or change request from a customer. In addition it links each 
ticket with the customer’s profile to easily reference the contact information and call 
history for the customer. The combination of ticket and customer history makes 
HEAT a very valuable tool for reports and analyzing past tickets. 

This document addresses two components of HEAT: 

• Call Logging: The HEAT application used to create, assign, track, and close 
tickets. 

• Alert Monitor: The HEAT application use to alert technicians when a ticket 
needs their attention. 

HEAT User Guide v8.4 January 2009 
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2. HEAT Tickets Overview 
2.1 When to Create a HEAT Ticket 

HEAT tickets should always be created for customers that report a problem, request a 
service, or request a change. HEAT tickets should also be created when you want a 
record of a request and its fulfillment; or a problem and its solution. 

• In general, you should create a HEAT ticket when the request for service is on a 
non-recurring basis. 

• Always create a HEAT ticket for change requests – regardless of the source. 
Change Management provides additional details concerning changes and 
customer notification requirements. 

• HEAT tickets do not need to be created when the customer is internal to OIT and 
the action resulting from the ticket is part of your daily duties. For instance, if you 
regularly create backups of a server you would not need to create a ticket. 
However if you receive a special request to create a one-time backup from a 
customer (including in OIT), creating a HEAT ticket would be appropriate.  

• If you regularly provide system support to customers outside of OIT as part of 
your job description, then when you provide similar support to a member of OIT 
you should create a HEAT ticket. For example, resetting a customer’s password. 

• HEAT tickets are normally not created for analysis, research, or project 
management tasks. The rationale is that the immediate impact is not normally 
apparent to the customer. 

HEAT User Guide v8.4 January 2009 

2 



Indian Health Service Office of Information Technology 

2.2 HEAT Ticket Lifecycle 
While the assignments and actions for each ticket vary, each HEAT ticket has a 
common lifecycle as shown in Figure 2-1. 

 

Figure 2-1: HEAT ticket lifecycle 

1. A request from a customer to solve an Information Technology (IT) or 
telecommunications problem, or to provide a service, initiates a ticket. This 
request is made directly to the OIT Help Desk. 

2. Regardless of how the ticket is initiated, the OIT Help Desk reviews the ticket and 
makes the appropriate assignment. 

• If the help desk analyst is able to resolve the problem or request, the ticket is 
assigned to the help desk analyst. 

• If specific technical expertise is required, the help desk analyst assigns the 
ticket to the appropriate technician or office in OIT. 

• If the ticket is the responsibility of another unit’s IT support staff and that unit 
does not use HEAT, the help desk will forward the request to the unit using e-
mail, close the ticket, and notify the customer of the change in assignment. 
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3. Upon receipt of a ticket assignment, the technician must acknowledge the ticket 
within four hours of the assignment. Alert Monitor is a very useful tool to notify 
the technician when a new ticket is assigned. The technician then performs the 
requested actions. If applicable, the technician may create additional assignments 
if not able to resolve the ticket or service request alone. 

4. The technician updates the ticket to document the completed actions. 

5. Once the problem is resolved or the service request fulfilled, the technician 
contacts the customer to confirm the resolution, preferably by phone. If unable to 
make contact with the customer by phone the technician should contact the 
customer via e-mail and document each contact attempt in a journal entry. 

6. The ticket is closed by the last technician to complete their assignment. 

7. If the customer receives IT support from the OIT, he or she will receive an e-mail 
when the ticket is closed. The e-mail states that the ticket has been closed and tells 
the customer what to do if the problem has not been resolved satisfactorily. 

Customer Quality Survey 
For 20% of these closed OIT tickets, a Customer Quality Survey request is e-
mailed rather than the standard notice. The customer has the opportunity to rate 
OIT’s quality of service and timeliness. All comments are reviewed by the OIT 
Help Desk. In all cases, when the customer does not agree that the problem was 
resolved or service provided, the OIT Help Desk will reopen the ticket. 

Refer to the Standard Operating Procedures Help Desk Ticket Escalation Procedures 
http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/documents/Ticket%20Escalati
on%20SOP%2010-10.pdf for additional information on the proper handling of 
tickets. 

2.3 Mandatory Fields 
When a ticket is created or closed, HEAT checks the ticket’s contents to make sure 
that all required fields and assignment have been completed. If not, HEAT identifies 
which fields still need to be completed. Required fields are denoted by an asterisk (*). 

2.4 Key Field Definitions 
It is especially important that the following fields on the Call Log tab in Call Logging 
are completed correctly for performance measuring purposes and to ensure that the 
tickets are resolved most expeditiously. See the following table. 

Table 2-1: Field Names and Definitions 

Field Name Definition 
Call Type The general nature of the problem. Options include Change, Problem, 

Critical Problem, and Service. 
System What is impacted? There are two simple options: Hardware or Software. 

HEAT User Guide v8.4 January 2009 
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Field Name Definition 
Category Category refers to a more specific description of the hardware or software 

that is impacted by the issue. 
Sub-Category An even more specific description of the issue. Options differ, depending 

on the Category selected above. RPMS SW, NPIRS, E-mail are only a few 
of the options. 

Status The current status of the ticket in HEAT. 
• Open: A ticket that is either being actively worked or needs to be 

worked. 
• Closed: A ticket that has been resolved and no further action is required 

from any HEAT technician. 
• Monitoring: A ticket that is believed to be resolved, but the technician 

wants to monitor it for awhile to check the effectiveness of the ticket’s 
resolution before closing the ticket. 

• Deferred: A ticket where further action must wait for another action 
that is not eminent. 

• Reopened: A ticket that was previously closed and later found not be 
resolved. The original ticket is reopened to be worked for a final 
resolution. 

Source  The source that best describes how the customer requested a service or 
change, or reported a problem. 
• E-mail: The ticket is created based on the receipt of an e-mail from a 

customer. 
• Fax: The ticket is created based on the receipt of a fax from a customer 

(e.g., an account request form). 
• In person: The ticket is created when a customer makes a request or 

reports a problem in person to a HEAT tracker or technician. An in 
person request often occurs when a customer alerts a technician to a new 
problem/request while the technician is at the customer's site working 
on another problem/request. 

• Phone: The ticket is created when a customer makes a request or reports 
a problem over the phone to a HEAT tracker or technician. 

• Self: When a ticket is created by the customer for himself/herself via 
Call Logging. 

• System Monitor: The ticket is created in response to an alert issued by 
a system monitor. 

• Voice Mail: The ticket is created based on the receipt of a voice mail 
from a customer. 

Owner • The IT support staff that services specific Indian Health Service units. 
Assign the ticket owner based on the customer’s unit not their location. 

• If in doubt, choose OIT and the OIT Help Desk will reassign the ticket 
as appropriate. 
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2.5 Requesting HEAT Accounts and Training 
To request a HEAT user account or HEAT training, open a HEAT ticket. This can be 
done by contacting the OIT Help Desk by the following means: 

• Phone: 505.248.4371 or 888.830.7280 

• E-mail a request to the Help Desk at 
http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

• E-mail a request to the Help Desk at support@ihs.gov 

• Have someone with HEAT access create a ticket on your behalf. 

For new accounts, the request should include the name of the account holder, unit, 
and the HEAT assignment group. If known, also list the alert monitor groups in which 
the account holder will need membership. The request should also state that the 
HEAT Client be installed on the technician’s computer at the same time. 

http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm
mailto:support@ihs.gov
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3. Alert Monitor Set Up 
Alert Monitor is a separate HEAT software application from Call Logging. It serves 
as a notification and monitoring tool for both technicians and managers. In order to 
be able to work in the Alert Monitor, you must set up a call group. 

Call Groups 
Tickets are managed in Alert Monitor through the use of Call Groups. Call Groups 
identify tickets with similar attributes – such as all open tickets assigned to a 
particular technician. Call Groups also control when you want to be notified of a new 
ticket that meets the call group’s criteria. For example, send a notification when a 
new ticket is added to the call group. 

Technicians must be logged into Alert Monitor to receive the notifications. OIT 
recommends that all HEAT users either keep Alert Monitor open or minimized on 
their computer’s desktop whenever they are using their computer. 

3.1 Logging In 
The following procedure provides instructions for logging into the HEAT Alert 
Monitor. 

To login to alert monitor: 

1. Double click Alert Monitor shown in Figure 3-2 on your desktop. 

 

Figure 3-1: Sample of Alert Monitor button 

If your HEAT account does not match your Active Directory (AD) account ID, or 
if do not have an AD account: 

• Enter your HEAT User ID and password or 

• Contact the OIT Help Desk to have your HEAT ID modified to match your 
AD account ID 
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Figure 3-2: HEAT Alert Monitor login screen 

2. Select an Option from the list to open an existing alert or create a new one. 

 

Figure 3-3: HEAT Alert Monitor login screen 

3. Click OK to continue. 

See Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (505) 248-4371 or (888) 830-7280 (toll free) 
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Fax: (505) 248-4363 

Web: http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

Email: support@ihs.gov 

Appendix A: Call Groups for information about creating an alert definition or Call 
Group. 

3.2 Viewing an Existing Ticket 
To open a ticket from the Alert Monitor. double click the call record for the ticket you 
wish to open. 

 

Figure 3-4: Alert Monitor with List of Active Calls 

The ticket opens in the HEAT Call Logging window as shown in Figure 3-34. 

 

Figure 3-1: Call Ticket 



Indian Health Service Office of Information Technology 

HEAT User Guide v8.4 January 2009 

10 

3.3 
From within the Alert Monitor you may view all the active and completed 
assignments for an individual ticket. 

To view the assignments for a ticket: 

1. Click the ticket, located in the upper pane, for which you want to view the 
assignments.  

The selected ticket’s assignments appear in the lower pane as shown in Figure 3-2. 

View Assignments 

 

Figure 3-2: View of ticket assignments 

rt order by clicking the column heading to toggle between 

 

 
 

2. Scroll to the right to view additional assignment details. 

3. Change the so
ascending and descending order. 

4. Resize the columns by moving the mouse over the column heading division lines
until its shape turns into a double-headed arrow. Click and drag the division line 
to resize the column. 

5. Click Save to save the column layout for the selected alert group. To change the
column widths in your other alert groups, repeat the column resizing for column
individually. 
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3.4 
, 

ary of the journal entries created for a specific ticket. Please 
et in 

ticket number to open the ticket in Call Logging.) 

for which you want to view the journal 
summary. See Figure 3-8 shown previously. 

2. Select View > Journals from the menu bar. 

A summary of all the journal entries appears. 

3. Scroll to the right to see the first part of the journal entry and view the journal 
entry text. 

4. Click the column heading to toggle the sort order between ascending and 
descending order. 

5. Click Print to print a journal summary. Be sure to change the paper layout to 
Landscape in the print dialog box. 

Viewing the Journal Summary 
The Journal is a free text field to capture pertinent information regarding the ticket
such as email text, steps taken, user input, and so on. From within the Alert Monitor 
you may view a summ
note that if you want to see the complete journal entry, you must open the tick
Call Logging. (Double click the 

To view the journal summary for a ticket take the following steps: 

1. Click the ticket located in the upper pane 

 

Figure 3-3: Journal dialog box example 
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4. Launching Call Logging 
To work and manage your tickets, you must open the Call Logging Module. 

To Open Call Logging from the Alert Monitor, click the Launch Call Logging button, 
as shown in Figure 4-1. 

 

Figure 4-1: Launching call logging 

HEAT User Guide v8.4 January 2009 
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4.1 HEAT Dashboard 
Call Logging opens by default to the Dashboard utility. The Dashboard displays 
information on the user’s group and important Broadcasts (messages that impact 
HEAT users). 

Using the tabs in the lower section of the screen, displays an overview of three 
different sorting options of all tickets in the HEAT system: 

• Active Incidents by Priority 

• Active Incidents by Call Type 

• Total Calls by Month 

 

Figure 4-1: HEAT Dashboard screen 

After you log into Call Logging, you may have the Dashboard show, or close it as 
you choose. See Figure 4-2. 

1. To open the Dashboard at any time, select View > Dashboard from the menu 
bar. 
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2. To close it, click Close (X) in the upper-right corner of the window. 

 

Figure 1-2: Sample of opening or closing dashboard 

3. The Call Logging window shown in Figure 1-3 appears. 

 

 

Figure 1-3: Call Logging window 
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4.2 Creating a Ticket 
The following procedure provides instructions for creating a ticket. 

To create a ticket: 

1. Click Launch Call Logging shown in Figure 1-4 from the Alert Monitor. 

 
 

Figure 1-4: Launch Call Logging button 

The Call Logging window appears. 

2. Select File > New Call Record from the menu bar or click New Call Record 
shown in Figure 1-5. 

 
 

Figure 1-5: New Call Record button 

3. Type the customer’s Last Name in the Last Name field, and then click in any other 
field to auto populate the customer’s information. 

The following conditions may occur: 

• If there is more than one customer in the HEAT database with the same last 
name, the Validate from Profile window opens. Choose the correct customer 
name and click OK. 

• If the customer is not listed in the HEAT database, the Validate from Profile 
window appears listing all available customer profiles. If you cannot find a 
match, contact the OIT Help Desk and ask them to create the customer’s 
profile. The customer’s profile must be created before you can continue with 
the ticket’s creation. 

Otherwise, the customer’s information defaults from the customer’s profile. 
Verify the customer’s information to ensure that the correct customer profile was 
defaulted. 

4. Confirm the customer’s Office, Phone, and E-mail Address. Update these fields as 
necessary by clicking Customer Profile shown in Figure 1-6 or by pressing F5. 

 
 

Figure 1-6: Customer Profile button 
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5. Click Caller History (shown in Figure 1-7) to determine if there is already an 
open ticket for this problem or service request for this customer. 

 

Figure 1-7: Caller History button 

• If there is an existing ticket, either update or reopen the ticket or abandon the 
ticket. Otherwise proceed with the next step. 

6. Close the Customer window to return to the call record. 

7. Fill in the Affected Site (site affected by the problem), Point of Contact, and 
POC Phone number. 

Note: This information may be different than the customer 
information above if the customer is calling about a site 
other than their own. 

8. Choose the appropriate Call Type by clicking the dropdown arrow by that field. 

The majority of the calls are either Service or Problem calls. See Table 1-1 for 
more information. 

Table 1-1: Call Types and Examples 

Call Type For 
Service • A customer requested modification that impacts a limited number, 

typically 10 or fewer, customers. 
Examples: 
• Moving desktop workstations 
• Creating Novell accounts 
• Loading software 
• Creating a web page 
• Provision of cellular phones or Blackberries 

Problem • Any unplanned outages, loss of functionality, or malfunctions in the 
software or hardware of an existing system. 

• Impacts one customer or has a minor impact on multiple customers. 
Examples: 

− Can’t print to a network printer 
− Can’t access e-mail or the network 
− Software doesn’t work properly 
− Web page link is broken 

HEAT User Guide v8.4 January 2009 
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Call Type For 
Change • Planned modification to production hardware or software that 

impacts/supports a significant number of customers – typically more than 
10. 

Examples: 
• Upgrading servers 
• Installing software to an entire Indian Health Service unit 
• Maintenance of network routers 

Critical 
Problem 

• Unplanned outage or major loss of functionality of production system(s) 
impacting multiple customers. 

• The initial ticket created for a critical problem will have a call type of 
Critical Problem.  If other customers call with the same problem, each of 
their tickets will have a call type of Problem cross-referencing the critical 
problem ticket.  

Note: Once you choose a call type, it should only be changed if 
the initial call type was incorrectly selected. 
 
For example when a ticket is created with a call type of 
Critical Problem, you should change its call type to 
Problem if you later discover that there is already another 
Critical Problem ticket addressing the same problem. 
 
Since you should not change a Call Type for example from 
a Critical Problem to a Problem just to keep the ticket open 
while confirming the effectiveness of the resolution. The 
correct action for this scenario is to change the Call Status 
to Monitoring, and to enter the Resolution Information 
Date and Time as of when the technician thinks the ticket 
was resolved. 

9. On the Call Log tab, the Call Status field is at the lower left of the screen. It 
defaults to Open. 

10. Accept the default. 
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11. Complete the remaining fields as they pertain to the service call you received as 
shown in Figure 1-8. 

 

Figure 1-8: Call Log tab in a new ticket created in Call Logging 

Additional information is provided in the Table 1-2. 

Table 1-2: Journal Fields and Values 

Field Value 
Source Choose the source that best describes how the customer requested a 

service or change, or reported a problem.  
Incident Description Enter a detailed description of the problem or service requested. Please do 

not repeat the customer’s name, call date and time in this field as the 
information is captured elsewhere in the ticket. 

12. Click Detail tab and complete the information. 

The Detail tab’s form varies based on the ticket Call Type. An example of the 
Detail RPMS Problem Screen appears when the Problem call type is selected. 
Figure 1-9 is provided as an example. 
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Figure 1-9: Detail RPMS Problem Screen 

Table 1-3 shows the call type and the corresponding fields. 

Table 1-3: Call Type and Related Fields 

Call Type 
If you select: 

Detail Tab Fields 

Service • Date Required and Time Required. If the customer does not specify a 
date/time by which they need the service provided, ask. If the customer 
still does not provide a date/time, leave the fields blank. 

• Estimated Completion Date. Leave blank. The should complete these 
fields after obtaining all the necessary information from the customer in 
order to provide this service.  

Problem 
 

• GUI Error Code. If the call pertains to an error in the GUI Scheduling 
application (i.e. Scheduling, Behavior Health GUI), enter the EXACT 
error message here. 
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Call Type 
If you select: 

Detail Tab Fields 

• Cache Error Code. If the call pertains to a traditional command line 
RPMS application like PIMS, Patient Registration and not a GUI 
interface, enter the EXACT code here. The format should be similar to 
this: <UNDEFINED>NMCH+10^AGZNDXP 

• RPMS Version. Enter the version of RPMS the customer is running. 
• GUI Client Version. Enter the version of the client computer the 

customer is running. 
• RPMS Patch. Enter the Patch number the client computer is running 
• OS Version. Enter the Operating System Version the customer is 

running. 
• New Functionality. Select yes if the call is a change or enhancement 

request. Select no if the call is not an enhancement, but rather a fix. 
Select N/A if neither applies. 

• New Functionality Description. If yes is selected in New 
Functionality, enter the details of the new functionality here. 

• Call Level: (to be entered by RPMS HEAT technician) Enter the Tier 
level of the call as follows: 
− Tier 1. Provided at the site level such as password resets, desktop 

support, and other common issues. 
− Tier 2. Provided by the Area IT office-examples include installation 

assistance of software, patches and updates, installation of LAN 
equipment, ect. 

− Tier 3. Provided by IHS OIT. Advanced level of support related to 
hardware, software, and telecommunications. Examples include 
troubleshooting of IHS-developed software (including RPMS, GUI 
Scheduling, ect.) maintenance of OIT-managed servers and WAN 
equipment and circuits. 

• Task Resolution Time: This is the actual time the technician spends 
actively working the ticket. It should be updated in minutes. For 
example, if you spent 15 minutes troubleshooting the issue, enter 15 min 
and save the ticket. Then if you went back in at a later time and worked 
the issue another 10 minutes, update the field to say 25 minutes, and so 
on. 

• Additional Information: Enter all other pertinent information here, 
such as other errors, specific details about the problem, other COTS 
applications running, ect. See Appendix D for additional 
troubleshooting questions to ask the customer. The goal is to get as 
much detail about the issue as possible upfront. 

Change • Change Type. Choose the most applicable. 
• Date Scheduled. The planned date for implementing the change. Indian 
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Call Type 
If you select: 

Detail Tab Fields 

Health Service policy requires that all changes apparent to the 
customers, or that will cause an outage must be approved by the CCB. 
The affected customers must also be notified at least 3 days in advance. 

• Time Scheduled. The planned start time of the change.  
• Est. Completion. This field only needs to be completed when the 

change will take longer than one day to complete. 
• Outage Required. Choose Yes if the customer’s service will be 

disrupted. If you are unsure, choose N/A. 
• Outage Duration. If there will be an outage, enter the length of time for 

the outage in hours and/or partial hours. For instance 30 minutes would 
be entered as 00.50. 

• Customer Notification Needed. 
− If change will not be noticeable by the customer and the does not 

require an outage, you may choose No. 
− If you are unsure, choose TBD. 
− Choose one of the following if the change will not be transparent to 

the customer (e.g. screen changes, or system outage), and attach a 
draft Change Notification request form to this ticket for review by 
the CCB: 
− IHS-Wide will go to everyone. 
− Targeted Customers will cover situation when notices only need 

to go to specific units like OIT staff. 
− IHS-NetMgmt (a distribution group whose membership includes 

IT support staff across the Institution.) 
− Other when notices need to go to groups like HEAT Trackers, 

Indian Health Service Webmasters, etc. 
• Approval Status. The initial status is Pending approval from the CCB. 

This field can only be updated by select staff. 
Critical Problem • Customer Impact Desc. Enter a brief description that will explain to 

the technician(s) the impact the problem is having on the customers. 
• Impact. Choose the most applicable level of impact to the customers. 

This field is used for categorizing critical problems and their level of 
occurrence in reports. 

• Impact Organization. Choose the value which best describes the units 
affected by the problem. 
− Multiple. More than one organization is affected. If you know which 

organizations, list them in the description. 
− See Organization. If the affected organization is the same as the 

customer’s organization for whom this ticket is being created. 
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Call Type 
If you select: 

Detail Tab Fields 

− IHS-Wide. Affecting everyone in the Indian Health Service. 
− Unknown. Aren’t sure which organizations are being affected. 
− Other. If the affected organization is different than the customer’s 

organization and none of the other options apply, list the affected 
organization in the description. 

• Number Impacted. Enter the estimated number of users being 
impacted by the problem. You may also enter a short text description 
such as All. 

13. Click the Assignment tab. The tab area is blank. 

14. Right click the Assignment tab and choose New Assignment. 

15. Complete the assignment information shown in Figure 1-10 as follows: 

• Group—choose the group to which the HEAT technician belongs who will be 
working the ticket. 

• Contact—choose the HEAT technician you wish to assign the call to. The 
technician’s information defaults. 

• Comments—enter any information that will be helpful for the technician to 
complete the assignment that is not recorded in the Incident Description or 
does not warrant a journal entry. 

 

Figure 1-10: Assignment Information  

16. If more than one technician works on this call, create another assignment for each 
technician by repeating Step # 13-15. 
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17. Select Save > Save Call Record, or click Save Call Record (shown in Figure 
1-11). 

   

Figure 1-11: Save Call Record button 

A Call ID (HEAT ticket number) is assigned to the call and is displayed in the 
upper left corner of the Call Logging window. 

 

Figure 1-12: Sample ticket showing assigned Call ID (ticket number) 

4.3 Putting an Unsaved Ticket on Hold  
Tickets that have not yet been saved can be placed on hold. When you place a ticket 
on hold, it allows you to create or open another ticket without first completing all the 
required information or start a ticket while you await additional information before 
assigning the ticket. The maximum number of calls you can simultaneously place on 
hold is 15. 

To place an unsaved ticket on hold: 

Choose File > Put Call on Hold from the menu bar without saving the ticket. 

When you place a call on hold, HEAT creates a special Calls On Hold Call 
Group. This group works like any other call group in Call Logging, except that 
the group's calls are only viewable from your computer. 

Once a call has been placed on hold an existing ticket may be viewed or a new 
ticket can be created. 
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4.4 Retrieving a Ticket from Hold 
The following procedure provides instructions for retrieving a ticket that was 
previously placed on hold. 

To retrieve a ticket placed on hold: 

1. Choose Window > Calls on Hold. 

 

Figure 1-13: Sample of calls on hold window 

2. Click the call record navigation buttons located on the toolbar to move between 
the calls in the Calls on Hold call group if more than one ticket was put on hold. 

 

Figure 1-14: Moving between calls using the arrows 

Note: Once you save a ticket that has been put on hold, it is 
removed from the Calls On Hold Call Group. 
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4.5 Opening an Existing Ticket 
HEAT tickets may be opened in several ways. 

• By the specific HEAT ticket number 

• From a call group (a grouping of tickets generally with the same technician or 
another common attribute) 

• From the alert monitor.  

To open a specific ticket in Call Logging: 

1. Choose File > Go To Call ID from the menu. 

2. Type the ticket number in Call ID field. 

 
Figure 1-15: Sample of screen used to enter call ID 

3. Click OK to open the ticket  

4.6 Acknowledging a Ticket 
The first step in working a HEAT ticket is acknowledging it. Acknowledging the 
ticket signifies that at a minimum you are aware of its existence. 

Note: Generally, tickets should be acknowledged within four (4) 
hours. You should use Alert Monitor to obtain notices of 
tickets needing your attention. 

To acknowledge a ticket: 

1. Open the ticket. 

2. Click the Assignment tab. 

3. Click Acknowledge… in the lower portion of the Call Logging screen. 

A date/time stamp showing when you resolved the assignment is shown in the 
Acknowledge field along with your HEAT User ID. 
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Figure 1-16: Sample of entering acknowledgement information 

4. Click Save Call Record shown in Figure 1-17. 

 
 

Figure 1-17: Save Call Record button 

4.7 Resolving an Assignment 
When you have completed your work on the HEAT ticket, you need to resolve your 
assignment. If you did not do any work on the HEAT ticket and need to assign it to 
someone else, see Reassigning a Ticket for more information. 

Note: Resolving an assignment does not close the ticket. After 
you resolve an assignment, the ticket may remain in your 
Alert Monitor if there are any other open assignments 
depending on how your Alert Monitor set up. 

To resolve an assignment: 

1. Open the ticket. 

2. Before you resolve the assignment, you should add a journal entry to document 
your actions (see the Adding a Journal Entry for more information). 

3. Click the Assignment tab. 

4. Click the Resolve… button, located immediately below the Acknowledge 
button.  

The Enter Value window opens. 

5. Click the dropdown arrow, and select either Completed or Reassigned as 
appropriate.  
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Figure 1-18: Sample of entering value to resolve ticket 

A date/time stamp stating when you resolved the assignment is shown in the 
Resolved field along with your HEAT User ID. 

6. Choose Completed in the Resolution field. 

Notes: If the technician does not need to perform any work related 
to a ticket, including reassigning the ticket, choose 
Completed in the resolution field.  
 
Conditions that can result in this include (1) customer fails 
to provided need info. After the technician notifies the 
customer, the ticket can be closed. (2) customer cancels a 
request for service; (3) multiple tickets were created for the 
same issue, and the assignment was extraneous. 

7. Click Save Call Record.  

If all assigned tasks from the ticket are complete, the ticket can now be closed. See 
Closing a Ticket for more information. 

8. Select Reassign in the Resolution code if the ticket has other tasks that need to be 
completed by another technician. See Creating a New Assignment for additional 
information. 

4.8 Creating a New Assignment 
Each HEAT ticket may be assigned to one or more HEAT technicians. Multiple 
assignments can be created at once, or additional assignments can be created at any 
time to an open ticket. To create a new assignment, see step 13 of Creating a Ticket. 
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4.9 Reassigning a Ticket 

Note: Never reassign a ticket by selecting a new name from the 
Technician field on the Assignment tab. The steps 
described below should always be followed to ensure that 
an audit trail is maintained on a ticket’s assignments. 

There are only two reasons when to reassign a ticket to someone else: 

• A ticket is assigned to you by mistake. 

• The only action you are taking on the ticket is to assign it to someone else for 
action. For example: 

– Supervisors may choose to have the all tickets in their area assigned to them 
and then assign them to someone on their staff. 

– One technician may reassign a ticket to a coworker with the same job duties 
whose workload is currently lighter. 

If the ticket was correctly assigned to you and you finish your assignment, do not 
reassign it to someone else. Instead you should resolve your assignment (see 
Resolving an Assignment for more information) and create a new assignment (see 
Creating a New Assignment for more information). 

To create a new assignment: 

1. Open the ticket. 

2. Click the Assignment tab. 

3. Click Resolve. 

 

Figure 1-19: Resolve button 

4. When the Enter Value window appears, use the dropdown arrow to select the 
appropriate resolution code. Select Reassigned. 

5. Click Validate. The Validate from Resolved window appears showing the 
resolution and description. 

6. Click OK. 

You are returned to the Enter Value window. 

7. Click OK. 
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8. If you are reassigning the ticket to another group because it was assigned to you 
error (versus to another member of your group), create a journal entry explaining 
the reason for the reassignment. 

9. Click Save Call Record. 

10. Create a new assignment as described in step 13 of Creating a Ticket. 

Note: If a ticket was assigned to you in error and you do not 
know to whom it should be assigned, reassign the ticket to 
the OIT Help Desk Manager. Please include in the 
Comments that This ticket was assigned to me by mistake 
and I don’t know to whom it belongs. Please reassign. 

4.10 Changing a Ticket’s Status to Monitoring 
There may be certain situations that warrant monitoring of a fix or change to ensure 
the issue was resolved and no additional problems exist. In this case, you would 
change the ticket’s status to Monitoring. 

4.11 Updating a Ticket 
After a ticket is saved, you may update any of its information on the call log and 
detail tabs. In fact, you should regularly update the Status/Solution field to keep the 
customer informed of the ticket’s progress. More details are provided in this section. 

To update a ticket’s status and information: 

1. Open the ticket. 

2. Update the ticket’s information. 

3. The following table provides additional information. 

4. Click Save Call Record after you complete all updates. 

HEAT User Guide v8.4 January 2009 

29 



Indian Health Service Office of Information Technology 

Update the… Guidance 
Call Log tab • You may update or correct any information on this tab. 

• If you are correcting information, add a journal entry briefly 
describing the correction. 

• It may be appropriate to update the Call Status before closing a ticket.  
− Choose Deferred if further action on the ticket must wait until 

another action is completed, or the ticket is pending a decision. 
− Choose Monitoring when you want to check the effectiveness of a 

ticket’s resolution before closing the ticket, and enter the 
Resolution Information Date and Time as of when the technician 
believes the ticket was resolved. 

• Resolution Information: Enter the date and time when the technician 
believes to have resolved the problem. This may be different than the 
date and time when the ticket is closed – especially if the tickt was 
being monitored. 

• The Status/Solution are the primary fields that the technician refers to 
check a ticket’s status: 
− Update it regularly to show progress on the ticket. 
− Use it to explain ticket dependencies such as waiting for completed 

request form from the customer. 
− When you update it, place your initials in parenthesis (e.g., (abc)) 

at the end of the comment so that other technicians and trackers 
will know who entered the update. 

− When updating the Status/Solution, it is always a good idea to cut-
and-paste the contents of the Status/Solution into the Journal – 
especially for time critical or sensitive information. 

− This extra step may help prevent problems later on if the 
status/solution is accidentally erased or modified. 

Detail tab • You may update or correct any information on this tab. 
• For service tickets, the technician should update the Date Customer 

Info Provided and Time Customer Info Provided fields. 
− If additional information was required before the service could be 

provided, enter the date and time when that information was 
obtained. 

− Otherwise if all the needed information was provided when the 
ticket was opened, enter the ticket’s original date and time.  

− Do not enter the close date and time. 
• If you are correcting information, add a journal entry briefly 

describing the correction. 
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Table 1-4: Updating Assignment tabs 

Assignment tab Never change the technician. If an assignment was made in error, follow the 
steps to reassign the ticket as described in the Reassigning a Ticket. 

Journal tab Add detailed information about the ticket and progress. 

4.12 Adding a Journal Entry 
Journal entries are used to record information such as additional customer provided 
details, status updates, resolutions, or notes for the next technician. 

Once a journal entry is saved, it cannot be changed. Therefore journal entries are a 
very good place to put information as a matter of record.  

To add a journal entry: 

1. Open the ticket from the Call Logging window. 

2. Click the Journal tab. 

3. Go to the Journal Type box and click the dropdown arrow to select from a list of 
recognized journal entry types. 

4. Type a comment describing the action you took, and complete the journal entry as 
shown in Figure 4-20. You may also edit existing journal entry text. 

Error! Reference source not found. Figure 4-20: Sample of creating a journal entry 
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5. Run a spell check on your journal entry by right clicking in the Journal Entry area 
and choose Spell Check. The spell check works similarly to other spell checks 
by identifying words not in its dictionary. You may choose a replacement word, 
ignore the word, or type a new word. 

 

Figure 1-20: Selecting Spell Check 

If necessary, you may abandon changes to the current journal entry by clicking 
Abandon Record shown in Figure 1-21, located on the menu bar. 

 
 

Figure 1-21: Abandon Record button 

Note: This also abandons any changes you made to the ticket 
since it was last saved. 

6. Click Save Call Record icon, or got to File>Save Call Record to save your 
journal entry. 

4.13 Closing a Ticket 
Once all of a ticket’s assignments are resolved, the ticket needs to be closed by the 
last technician. 

Note: Do not close the ticket until you are finished adding all 
information to it (e.g. journal entries). Once a ticket is 
closed, its information cannot be changed without 
reopening the ticket. 

To close a ticket: 

1. Open the ticket. 

2. Go to the Call Log tab. Make note all of the current Solution Description entries 
which show the progress of the ticket as it was being worked, and copy them into 
a journal entry. 
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• Highlight the Solution Description text. 

• Press the Ctrl key with the c key to copy the text. 

• Click the Journal tab. 

• Copy this final Solution Description text into a journal entry. 

• Enter the final solution or resolution into the Solution Description field. 

– Click within the Journal Entry box and press the Ctrl key with the v key to 
add the solution text. 

– For problems, include the detail about the cause of the problem (if known) 
and the steps used to solve it. 

Copying the solution description text to the journal ensures that the information 
you entered is not lost during future ticket updates, such as reopening a ticket. 

Closing Tickets 

For all tickets, click the Detail tab to display Detail Screen, and 
update the all the required information here. 

Do not enter the close date and time in these fields. 

3. Click the Call Log tab. 

4. Go to the lower right of the Solution Description area. In the UVF (User Verified 
the Fix) field, click the dropdown arrow and select the option that best indicates 
whether the customer verified the fix or resolution met their expectations (N/A, 
Yes, or No). 

Note: Every effort should be made to contact the customer to 
verify that the ticket was completed satisfactorily. 
Whenever possible, contact the customer in person or via 
phone. Otherwise, contact the customer through e-mail. 
 
Document each contact attempt as a journal entry in the 
ticket. If after three attempts on three different days, the 
customer has not respond, close the ticket and list UVF as 
no. 

5. In the Incident Cause field, choose the most appropriate reason for the initial 
ticket. 

• Failure when the problem was due to hardware failing or a bug found in the 
software. 

• Request when the ticket is a service request initiated by the customer. 

• Scheduled work when the ticket is a service request for regularly scheduled 
maintenance activities. 
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• User Error when the user made a mistake or did not know how to use the 
hardware or software. Usually training should be provided to the customer to 
prevent the problem from reoccurring. 

• Virus when the problem was due to a confirmed virus infection.  

• Other for any other cause. 

6. In the Reason for Closure field, choose from the following: 

• Completed when the problem or service request was completed. 

• Invalid Ticket when the ticket was created in error.  

• Canceled by Assignee should only be selected when the assignment cannot 
be accomplished due to technical or budget constraints. The technician must 
contact the customer to explain why the ticket was closed, and whenever 
possible help identify alternatives the customer can explore to satisfy their 
needs. 

• Redirected Customer to…is selected when the responsible staff for fulfilling 
the problem or service request is not a technician in the OIT maintained 
HEAT database. 

• Canceled by Customer occurs when the customer decides the problem or 
service requested is no longer an issue and/or the request was done in error. 

• No Customer Response is selected when several attempted calls or emails 
have been submitted for additional information from the customer and no 
response has been reciprocated  

• Otherwise, choose the most appropriate reason for the ticket not being 
completed as described in the Incident Description. 

7. In the Resolution Information area, enter the date and time details of when the 
technician believes the ticket was actually resolved, for example the date and time 
prior to being put in monitoring status. Otherwise, enter the current date and time. 

8. Go to the Milestones area in the lower right of the screen. In the Closed By field 
enter the date and time. 

9. Click Quick Close to change the ticket status to Closed. 

 
Figure 1-22: Quick Close button 
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Figure 1-23: Sample of closed ticket 

HEAT checks the ticket’s contents to see if all the assignments are resolved and 
all the mandatory fields completed. If not, a message box appears to remind you 
of required fields or actions that must be completed before you can close the 
ticket. Once all the requirements are met, you can close the ticket. 

10. Confirm that the Call Status is Closed. 

11. Save your work and click Save Call Record icon. 
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4.14 Reopening a Ticket 
A closed ticket can be reopened when it was closed erroneously, additional 
information needs to be added to the ticket, or the customer does not feel it was 
resolved. 

In addition after a customer has verified a fix, problem and critical problem tickets 
should only be re-opened if the problem reoccurs on the same day as when the ticket 
was initially marked resolved. Otherwise, create a new ticket and reference the old 
ticket number. 

Notes: The steps described below must be followed when 
reopening a ticket to move the ticket’s status information to 
a journal entry in the ticket. Otherwise the contents of the 
status will be lost. 

To reopen a ticket: 

1. Open the closed ticket. 

2. Choose File > Reopen Call Record. 

3. Click Yes in the dialog box shown in Figure 1-24 to move the status to a journal 
entry. Otherwise, the old status information could be lost. 

 

Figure 1-24: Moving text to a journal entry 

A journal entry is created showing the date and time that the ticket was originally 
closed, the technician that originally closed the ticket, the reason for the closure, 
and the solution description. 

At the top of the screen, the status of the call is now Reopened. 

4. Create a journal entry explaining the reason for reopening the ticket.  

If you do not plan to immediately close the reopened ticket, create a new 
assignment for the ticket. 

5. Click Save Call Record. 
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Figure 1-25 

Figure 1-25: Activity Log for a particular call ID, and Activity Log button. 

3. Click Help for more information about the column headings.

If you are finished updating the ticket and no further action is required, close the 
ticket as described in the Closing a Ticket. 

4.15 Viewing Activity Log 
HEAT tracks all the activity (or history) of each ticket in an Activity Log. This log 
shows details such as when the call status changed or the call type change. In 
addition, it identifies the technician who made the change along with the date and 
time. 

To look at a ticket’s history: 

1. Open the ticket. 

2. Go to View > Activity Log from the menu bar, or click Activity Log shown in 
Figure 4-26. 
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5. Customer Information: Step-by-Step 
Instructions 

HEAT stores information about each customer as a customer profile. This 
information is accessed each time you create a ticket for a customer. At the Indian 
Health Service, generally only HEAT Administrators may create new customer 
profiles. However all HEAT trackers may view this information, make updates, and 
review the call history of a customer. 

Note: Do not create a ticket just to look up a customer’s 
information, and later abandon it. Abandoned tickets are 
also assigned ticket numbers. Instead follow the steps 
defined in this section. 

5.1 Viewing a Customer Profile 
This procedure provides instructions for viewing a customer profile. 

To look at a customer profile: 

1. From the Call Logging menu, choose Customer > Search. 

2. The Profile Search window appears. For the Customer Type choose Employee. 

3. Enter your search criteria following one of the examples below. 

4. 4Click Search. 

The examples show using the “like” operator. Searches for “like” matches that begin 
with the same as the value you entered. If you have a high level of confidence in your 
search criteria, you may use the equal sign (=) operator to find exact matches. 

HEAT ID Search 
To search based on the HEAT ID, enter the search criteria where: 

• Field  = Profile.CustID 

• Operator = like 

• Value = <enter the customer’s HEAT ID> 
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Examples: 

 
Figure 5-1: Sample of entering search criteria 

Last Name Search 
To search based on the last name, enter the search criteria where: 

• Field  = Profile.LastName 

• Operator = like 

• Value = <enter the customer’s last name or the first few letters of the last name> 

 
Figure 5-2: Sample of entering search criteria 
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5.2 Displaying a Customer’s Ticket History  
In HEAT, you can easily view all of a customer’s past and current tickets. This is 
especially helpful for verifying that the current problem or service request wasn’t 
previously reported. It also allows you to see if this is a recurring problem and review 
the past actions taken to resolve the problem. 

To look at a customer’s ticket history: 

1. If you are currently viewing a new or existing ticket for the customer, click the 
Customer Profile button. Otherwise go to the menu bar and select View > 
Profile. 

 
 

Figure 5-3: Customer Profile button  

2. Click the Call History tab. 

 
Figure 5-4: Sample of screen used to view call history 

3. To sort the tickets, click the column heading by which you want the results sorted. 
For example, you could click the RecvdDate column to view the most recently 
opened tickets. 

4. To view a ticket, double click the ticket number. 

5.3 Updating a Customer Profile 
In HEAT, you can update an existing HEAT Profile. However the addition of new 
customers can only be done by the HEAT System Administrators. If you come across 
a customer who is not listed in HEAT, please contact the OIT Help Desk. 
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To update a customer profile: 

1. Open a new or existing ticket for the customer.  

2. Click Customer Profile 

3. Go to the Profile tab. Here you may update all the information, except the HEAT 
ID. 

4. Click Save Customer Record to save your updates. 

5.4 Requesting a New Report 
If you require a custom report, submit a request to the OIT Help Desk outlining your 
requirements. If there is a similar standard or custom report, please reference it in 
your request noting any required modifications required to meet your needs. 

5.5 Conducting a Simple Search 
A Simple Search can quickly find a ticket by searching for all tickets with a common 
feature, such as Software or the name of a technician. 

Normally simple searches are done when a tracker or technician is viewing an 
existing ticket and wants to see more like it. More like it would be any tickets that 
match one (1) condition, such as the same System, technician, or hardware type. Most 
of the fields have this search feature. 

To conduct a simple search: 

1. Open a ticket. 

2. Right click the field on which you want to base your search. 

If you start your search from a blank ticket or an existing one that was not opened 
as part of a call group, the entire HEAT database will be searched. 

A menu appears. 

3. Choose Simple Search... 

4. The simple search window opens automatically displaying the same Value that 
was in the ticket from which you began the search. You will see that in the 
following example Office is the field on which the sort was based. 

• If you start your search from a ticket that is part of a call group or search 
results (a temporary call group), only the tickets in the call group will be 
searched when Narrow an open call group is checked. 
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Figure 5-5: Simple Search options 

5. If you want to search for another value in this field, delete the contents in the 
Value field and click the Browse… button to select another value.  

6. Click the Run button. Only the calls that match your search criteria will appear. 

7. HEAT displays the last ticket it found that matched your search criteria. Note the 
information displayed in the following example of the Call Logging screen.  

 

Figure 5-6: Sample of ticket found with search 

You can navigate through all the matches using the call record navigation buttons 
located on the toolbar to view the other matches. 

 

Figure 5-7: Illustration of using call record navigation 

If you would like to view a summary of each of the tickets found, from the menu 
bar go to Group > Call Record Browse. 

The Call Record Browse window opens, summarizing all the tickets found during 
the search. Double-click on any call ID to go to the ticket. 
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Figure 5-8: Sample of window showing summary of tickets found in search 

8. To start a new search of the entire HEAT database, repeat the simple search, but 
uncheck the Narrow an open call group option. 

 

Figure 5-9: Sample of simple search of entire database 

With HEAT 8.4 you also have the option of creating a new call group each time you 
refine a simple search. This allows you to keep your previous search results in the 
current call group. To use this option, check both Create a new call group and 
Narrow an open call group in the Simple Search window. 

 

Figure 5-10: Sample of creating a call group for the search and narrowing a call group
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6. Attachments: Step-by-Step Instructions 
You may attach one or more files or URLs to a ticket. In order for all technicians to 
view the attachments, the files must be located in a directory accessible by all HEAT 
technicians. The OIT Help Desk created the \\heat1\attachments directory for this 
purpose. After you map to this directory, you will need to log into it each time you 
log into the network. 

Because the attachments are part of the HEAT ticket, it is important that they are not 
removed from this directory either by accidentally deleting, replacing, or renaming an 
attachment. Safeguards have been put in place to prevent this type of accident. 
However, technicians should also follow these basic rules: 

• Unique Name: Make each attachment’s name unique by naming it with the 
ticket’s number as well as a short description. 

• Journal Entry: Each time you add or modify an attachment create a journal entry 
in the ticket describing your actions for auditing purposes. 

6.1 Attaching a File 
To attach a file to a ticket: 

1. Open the call record to which you are adding the attachment. 

2. Click the Display Attachment Bar Menu button in the lower left corner of the 
Call Logging window. 

 

Figure 6-1: Attachment button location 

3. From the pop-up menu, choose Add Attachment. 

 

 

Figure 6-2: Selecting Add Attachment 

4. In the Enter New Attachment Information for Call ID #xxxxxx window take the 
following actions: 
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• Type a brief Description of the attachment (maximum of 26 characters). 

• Check the Copy Attachment box. This is required to save a copy of the file 
on the HEAT Attachment directory allowing other people to open the 
attachment. 

• Click the Browse button to locate the complete File Name (URLs may also 
be entered). 

 

Figure 6-3: Enter New Attachment Information dialog box 

5. Click OK. The attachment appears on the Attachment bar. 

 

Figure 6-4 Sample of window showing attachment 

6. Add a journal entry to the call record documenting the name and source of the 
attachment that was just added. This creates an audit trail in case something 
accidentally happens to the attachment. 

6.2 Viewing an Attachment 
To look at the attachments for a ticket: 

1. Open the ticket call record that contains the attachment. 

2. Click the attachment’s button located on the Attachment Bar, as shown in the 
previous example. It may take a few seconds for the attachment to open. 
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Note: If you receive an error message that an attachment is not 
found, contact the OIT Help Desk to have them reattach the 
attachment. You will need to provide the following: 

Ticket number 

Name of the attachment that is missing. 

6.3 Editing an Attachment 
Due to access controls implemented with HEAT 8, you cannot edit an attachment’s 
description or location.  

• To change the file that is attached, create another attachment (see the Attach a 
File section of this document) with a unique file name and attach it to the ticket. 
Please remember to add a journal entry briefly summarizing the reason why the 
updated attached file was added.  

• To change an attachment’s description, contact the OIT Help Desk to have the 
description updated. You will need to provide the ticket number and both the old 
and new description for the attachment. 
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6.4 Removing an Attachment 
To remove an attachment from a ticket: 

1. Contact IHS OIT User Support and ask for the attachment to be removed. 

2. Add a journal entry describing why the attachment was removed. 
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7. Tips and Tricks  

7.1 Shortcut Keys: Call Logging 
With the cursor located in a field, you may press the shortcut keys to take the desired 
action. 

Table 7-1: Call Logging Actions and Shortcut Keys 

Action Shortcut Key 
Clear a date or time field F2 
Fill in System Date or Time 
(while in a date or a time field) F3 

Display Calendar (while in a date field) F4 
Display all the allowable values for a field F9 
Go to the Call ID Ctrl+G 
New Assignment Ctrl+A 
New Call Ctrl+N 
New Journal Ctrl+J 
Put a Call on Hold Ctrl+H 
Quick Close F10 
Save Ctrl+S 
Spell Check (the current field) Shift + F9 

7.2 Navigation Keys: Call Logging 
Press the shortcut keys to quickly move between tickets, or a ticket’s tab. 

Table 7-2: Navigation Actions and Shortcut Keys 

Action Shortcut Key 
Previous Call F7 
Next Call F8 
First Call Shift+F7 
Last Call Shift+F8 
Call Log Alt+1 
Detail Alt+2 
Assignment Alt+3 
Journal Alt+4 
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7.3 Shortcut Keys: Alert Monitor 
While in Alert Monitor, you may press the shortcut keys to take the desired action. 

Table 7-3: Alert Monitor Actions and Shortcut Keys 

Action Shortcut Key 
Define a Call Group Alert CTRL+G 
Define a System Message Alert CTRL+M 
New Alert Definition CTRL+N 
Open a Call Group Alert Definition CTRL+O 
Poll Now F5 
Save CTRL+S 
Start/Stop Polling 
(toggles back and forth) 

F2 

View Alert Summary F8 
View Journal Entries CTRL+J 

Figure 11-3: Table of actions and shortcut keys 

7.4 Spell Check 
In Call Logging, you may spell check any text entry field. Unfortunately, Call 
Logging only allows you to spell check one field at a time. At a minimum, we 
recommend that you spell check the Description of the Problem/Request, the 
Status/Solution, and all journal entries. 

To spell check the contents of a field: 

1. Place the cursor in the text field you want to spell check. 

2. Click Spell Check (shown in Figure 7-1). 

Please note that only some fields have the spell check option. If a field does not 
have the spell check option, the Spell Check button on the toolbar is grayed out. 

 
 

Figure 7-1 Spell Check button 
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Spell Check feedback and correction options are provided, as shown in Figure 
7-2. 

 

Figure 7-2: Sample of Check Spelling window
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8. Troubleshooting 

8.1 Cannot Update a Ticket 
A ticket cannot be updated when its status is Closed. If you need to make an update to 
a closed ticket, please follow the steps in the Reopen a Ticket section of this 
document. This section describes how to reopen a ticket. 

However if the ticket’s status is anything other than Closed (for example open, 
monitoring, or reopened), and you cannot update the ticket or select any dropdown 
menus, then the ticket has most likely been locked by the HEAT server. Contact the 
OIT Help Desk to request that the ticket be unlocked by the HEAT System 
Administrator.
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9. Glossary 
Abandon 

To cancel the creation of a ticket or changes to a ticket (e.g., journal entries or 
assignments) that have not yet been saved. 

DA 
Active Directory 

AIS 
An assemblage of hardware, software, firmware, or any combination of these, 
configured to accomplish specific information-handling operations, such as 
communication, computation, dissemination, processing, and storage of 
information. This includes computers, networks, or other electronic 
information handling systems, and the associated equipment. 

Alert Monitor 
The software application in HEAT that notifies technicians of tickets requiring 
their attention. Tickets may also be opened from within Alert Monitor. 

Assignee 
Technician. A person responsible for an action on a help desk ticket. 

Call Group 
A collection of tickets that generally have something in common. For 
instance, all open tickets, or all the tickets assigned to the same person. 

Call ID 
A unique reference number assigned by HEAT to a help desk ticket.  

Call Logging 
The core software application of the HEAT system used to log, track, and 
resolve help desk tickets (calls). It also provides a database for queries and 
reporting. 

Call Record 
The term that HEAT uses to refer to a help desk ticket. See Ticket. 

Customer Record 
An important component of Call Logging that contains information about 
customers including their call history. 
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HEAT Board 
A centrally located bulletin board in HEAT’s Call Logging used to post 
general messages of interest to other technicians (for instance the status of a 
system outage) and to link related tickets to one another. 

Journal Entry 
A permanent memo field used to record important information about a ticket – 
including its status/solution. 

Orphan Ticket 
An orphan ticket is an open ticket that does not have any active assignments. 
Either all the assignments were resolved and the ticket was never closed; or, 
the ticket was never assigned to anyone. 

Technician 
A person responsible for an action on a help desk ticket. 

Ticket 
Contains the complete history and status of a customer service request, 
problem, critical problem, or change request. Tickets are used to assign, track, 
record, and report on an individual ticket’s progress. 

UVF 
User verified the fix. 
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10. Contact Information 
If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (505) 248-4371 or (888) 830-7280 (toll free) 

Fax: (505) 248-4363 

Web: http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

Email: support@ihs.gov 

HEAT User Guide v8.4 January 2009 
54 



Indian Health Service Office of Information Technology 

11. Appendix A: Call Groups 

11.1 Call Groups Overview 
Call Groups put together tickets with similar attributes – such as all open tickets 
assigned to a particular technician. Call Groups also control when you want to be 
notified of a new ticket that meets the call group’s criteria. Most likely when your 
HEAT account was created, default call groups were assigned to your login account. 

There are three categories of Call Groups as follows: 

Personal 
Call groups that you create for your use only. They are private and cannot be shared 
with other HEAT technicians. 

Team 
Call groups that were setup for use by HEAT technicians that belong to the same 
HEAT Group.  

Global 
Call groups for use by all technicians. 

11.2 Adding an Existing Call Group 
When you log into Alert Monitor, it automatically opens the call groups saved in your 
profile. You may add an existing Call Group (one that was previously defined by you 
or the HEAT system administrator) to your profile. 

To add an existing call group, take the following steps: 

1. Click the Start/Stop Polling button to stop the polling for new tickets. Polling 
must be turned off while working with call groups. 

 
 

Figure 11-1: Sample of Start/Stop Polling button 

When polling is on many of the menu and toolbar options are grayed out, as 
shown in the following example. 

 

Figure 11-2: Sample of tool bar with unavailable options 
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2. Click the Define call group alerts button.  

 
 

Figure 11-3: Sample of Define call group alerts button 

A window opens displaying your currently selected call groups. 

3. Click New. 

 

Figure 11-4: Call Group Alert Definition dialog box 

The Define Call Group Alert window appears.  

4. Click Browse. 

 
Figure 11-5: Sample of window showing Browse button  
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5. Select the radio button corresponding to the type of Call Groups you wish to 
browse, as shown in the next example. These options include the following: 

• Personal: Call groups you created for yourself. Please note that you will only 
see your own alert groups. 

• Team: Call groups created by the HEAT System Administrator specifically 
for your team (HEAT Group) members. 

• Global: Call groups created by the HEAT System Administrator available to 
all HEAT users. Please note that if a call group will be used by more than one 
team, it must be stored at the global level. 

• All: All of the above. 

 

Figure 11-6: Open Call Group dialog box with preceding boxes open below it 

6. Click the name of the call group you want to add your profile. 

7. Click the Open button. You will be taken back to the Define Call Group Alert 
window. 

8. The Define Call Group Alert window allows you to choose when to Generate I….  

9. Select one of the three options provided by clicking the check-box as shown in 
Figure 11-7Figure 11-7. Your choices are: 

• Any Calls are Found 

• Calls are Added 

• Calls are Removed 
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Figure 11-7: Define a Call Group Alert dialog box 

10. Click OK. 

11. Click Exit. 

12. Click Save. 

13. Click Start/Stop Polling (traffic signal button) to turn on polling. 

11.3 Changing a Call Group’s Alerts or Display Preferences 
Call Groups may be customized to match your preferences. At any time, you may 
change: 

• When you want to be notified of a change in your call group 

• The type of information displayed about each ticket in your call group (the grid 
layout) 

These changes only affect your display – not anyone else’s. You may therefore 
change any personal, team, or global call group preference. 

To change a call group’s preferences: 

1. Click the Start/Stop Polling button to stop the polling for new tickets. Polling 
must be turned off while working with call groups. 

 

Figure 11-8: Start/Stop Polling button 

Remember – when polling is on many menu and toolbar options are grayed out. 
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2. Click Define call group alerts.  

 
 

Figure 11-9: Sample of Define call group alerts button 

3. Click the alert group you want to edit. See the following example. 

 

Figure 11-10: Sample of choosing an alert group for editing 

4. Click Edit. 

5. Choose when you want to be notified of a change to the call group from the 
Generate an alert if options. 

 

Figure 11-11: Sample of alert notification options 
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6. To change the summary information that is displayed in the Call Group window, 
click the Grid button.  

7. The Grid Definition window appears. To add a field, click the field’s name in the 
Available Fields column then click the Add button. See the following example. 

 

Figure 11-12: Sample of Grid Definition screen 

8. To remove a field, click the field’s name in the Selected Fields column then click 
the Remove button. 

9. To change the order of the selected fields, click the field you want to move. Then 
click either the Move Up or Move Down button to reposition the field. 

10. When you have finished making your changes in the Grid Definition window, 
click the OK button. 

11. Click the Save button. 

12. Click the Start/Stop Polling (traffic signal) button to turn polling on again. 

11.4 Creating a New Personal Call Group 
The instructions below show how to create a Personal Call Group. Personal call 
groups are private and cannot be shared with other HEAT technicians.  

If you need a Global or Team Call Group created, contact the OIT Help Desk or 
create a ticket to request this service. Global and Team Call Groups may only be 
created the HEAT System Administrator. 
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When you create a Personal Call Group, you are actually using Boolean logic. If you 
already understand that, you will recognize it in the steps described in this section. 
Just follow the steps provided. If you need additional information or would prefer to 
have the HEAT System Administrator create your personal call group, then contact 
the OIT Help Desk for assistance. 

To create a new call group, take the following steps: 

1. Click the Start/Stop Polling button to stop the polling for new tickets. Polling 
must be turned off while working with call groups. 

 

Figure 11-13: Sample of Start/Stop Polling button 

Remember – when polling is on many menu and toolbar options are grayed out. 

2. Click Define call group alerts.  

 
 

Figure 11-14: Sample of Define call group alerts button 

3. Click New on the Call Group Definition dialog box shown in Figure 11-15. 

 

Figure 11-15: Call Group Alert Definition dialog box 

The Define Call Group Alert dialog box shown in Figure 11-16 appears.  
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Figure 11-16: Sample of screen used to create a new call group 

4. Click Browse. 

The Open Call Group dialog box shown in Figure 11-17 appears. 

 

Figure 11-17: Open Call Group dialog box 

5. Click Add. 

6. In the Name box, type the name of your Call Group. It can be called anything you 
want. 
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7. In the Description box, type a brief description of the Call Group. 

8. Click the Personal radio button. See the following example. 

 

Figure 11-18: Sample of entering new group information 

The next step involves defining the criteria (expression text) that the tickets must 
meet to appear in the new call group. Boolean logic is used to create the criteria for 
determining which tickets should appear in the call group. 

11.5 Using Operators 
Following is a short primer. If you need additional help, then click the Help button or 
contact the OIT Help Desk for additional assistance. 

• Table Name: Displays the HEAT tables (generally the tabs displayed on a ticket) 
and @functions (e.g., the @current date) available for use. When you select a 
table, the available fields for that table appear in the Field list. 

• Field Text: Displays the fields available in the selected table.  

• Operators: Operators are used to define the condition the selected field must 
meet. Note the information in the following table. 
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Table 11-1: Operators and Definitions 

Operator Definition 
= Equal to 
< Less than 
<= Less than or equal to 
<> Not equal to 
> Greater than 
>= Greater than or equal to 
Is empty Nothing is entered in the field 
Is null Nothing is entered in the field 
Is not empty Anything is entered in the field 
Is not null Anything is entered in the field 
Like Contains the specified value anywhere in the field 

To create an expression using operators: 

1. Choose a table containing the field you want to add to the expression. See the 
example of the New Group window in the previous example (Figure 11-18). On 
the left side of the New Group window, find Table Name. Use the dropdown box 
to select a table. 

2. Double click the field containing the table you want to use. It will appear in the 
expression box. 

3. Double click an operator. It will appear in the expression box. 

4. Either click Browse Field Data, or type in a value to complete the expression. 
See the following example. 

 

Figure 11-19: New Group dialog box where operators are used to create an expression 
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If you click the Browse Field Data button the Validate from Status dialog box 
appears. 

5. Select the expression you want to use and click OK. You are returned to the New 
Group dialog box. 

 

Figure 11-20: Sample of browsing field data to select an expression 

6. If there will be more than one condition, click either And or Or to connect 
multiple conditions, and repeat the process until your expression is complete. 

 

Figure 11-21: Sample of adding conditions 

7. Click Check to verify that your expression works. If it does not work, you 
receive an error message indicating what needs to be corrected. 
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Note: It is very important that you click Check and correct any 
errors. If you save a personal alert group with an error, your 
Alert Monitor may crash. 

8. Click Order By to choose how to display the results in the call group. 

9. Click the first field by which you want to sort the results and the radio button for 
either Ascending or Descending order. 

 

Figure 11-22: Order By dialog box 

10. Click Add >> in the Order By dialog box. 

11. Repeat the last two steps to add additional sorting parameters. The second 
parameter sorts the list within the order of the first parameter, and so on. 

If you need to remove an order by parameter, highlight it and click <<Remove. 
To change the sort order, remove the entire contents of the Order by List and add 
them back in the correct order. 

12. Click OK. 

13. Click Save to save your new call group.  

You have completed creating the call group. Now you must add it to your list of 
open call groups. 
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14. Click the name of the call group you just created. 

 

Figure 11-23: Sample of call group window 

15. Click Open shown in Figure 11-23. 

16. Choose one of the following options from the Define Call Group Alert dialog box 
shown in Figure 11-24:  

• Any Calls are Found 

• Calls are Added 

• Calls are Removed 

 

Figure 11-24: Sample of generating call group alerts 

17. Click OK. 

18. Click Exit. A window for your new Call Group opens automatically. 
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19. Click Save to save the new call group to your list of open call group alerts. 

20. Click Start/Stop Polling (traffic signal) to turn polling on again. 

11.6 Changing an Existing Call Group’s Selection Criteria  
The following instructions show how to change a Personal Call Group.  

If you need a change made to a Global or Team Call Group, contact the OIT Help 
Desk, or create a ticket to request this service. In most instances, the OIT Help Desk 
will create a similar call group thereby preserving the existing call group for other 
HEAT technicians. 

To edit an existing call group: 

1. Click Start/Stop Polling (traffic signal) to stop the polling for new tickets. 
Polling must be turned off while working with call groups. 

Remember – when polling is on many menu and toolbar options are grayed out. 

2. Click Define call group alerts.  

 
 

Figure 11-25: Define call group alerts button 

The Call Group Alert Definitions dialog box shown in Figure 11-26 appears. 

 

Figure 11-26: Call Group Alert Definition dialog box 
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3. Click Edit. The Edit Alert Group dialog box shown in Figure 11-27 appears. 

 

Figure 11-27: Edit Alert Group dialog box 

3. Click Browse…. 

The Open Call Group dialog box shown in Figure 11-28 appears.  

4. Click Personal then click the name of the call group you want to edit. 

 

Figure 11-28: Open Call Group dialog box 

5. Click Edit…. 

6. Make the necessary changes to the call group: 

• Name: You can name a Call Group anything you want. 
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• Description: Type a brief description of the Call Group. 

 

Figure 11-29: Edit Call Group dialog box 

7. To edit the expression text, either: 

• Edit the text directly in the expression box. 

• Or, place the cursor in the Expression Text box where you want to begin your 
edits and follow the steps as described in Creating a New Personal Call 
Group. 

8. Click Check to verify that your new expression works properly. If it does not, 
you receive an error message indicating what needs to be corrected. 

9. Click Order By…,to display the Order By dialog box shown in Figure 11-30> 

10.  Change how the results are displayed in the call group as follows: 

• To add a field, click the field you want to sort the results by and the radio 
button for either Ascending or Descending order. Then click Add >>. 

• To remove a field, click the field you want to remove. Then click <<Remove. 

• To change the order of the sort, you must remove all the Order by List entries 
and add them back in the correct order.  
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Figure 11-30: Order By dialog box 

11. Click OK if you made changes you want to save. 

12. Click Save to save the changes you made to the call group.  

13. Click Close. 

14. Click OK. 

15. Click Exit. 

16.   Click Start/Stop Polling (traffic signal) to turn polling back on.
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12. Appendix B: AutoTasks, Step-by-Step 
Instructions  

AutoTasks are created by the Indian Health Service HEAT System Administrator for 
your use. AutoTasks automate routine or repetitive actions. This makes HEAT easier 
and faster to use. You can also place an AutoTask button on your toolbar to make it 
even easier.  

This chapter includes directions on how to use AutoTasks. If these examples give you 
ideas for additional AutoTasks, create a service ticket to submit your request to the 
HEAT system administrators. 

12.1 Adding an AutoTask to Toolbar 
This procedure provides instructions for adding an AutoTask button to your toolbar. 

To add an AutoTask button to your toolbar: 

1. From the menu, choose AutoTask > Manage AutoTasks, and the Manage 
AutoTasks dialog box shown in Figure 13-1 appears. 

 
Figure 13-1: Sample of Manage AutoTasks window 

2. In the View section, select All. 

3. Click once to select the AutoTask you want to add to your toolbar. 

4. Click Associated Toolbar Button in the lower right area of the dialog box. 
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5. Choose a button of your choice from the dialog box shown in Figure 13-2. 

 

Figure 13-2: Select Image dialog box 

6. Click OK.  

You are returned to the Manage AutoTasks dialog box 

7. . Click Close, and the button appears on the right side of your toolbar as shown in 
Figure 13-3. 

 
 

Figure 13-3: Sample of toolbar with newly chosen button 

12.2 Removing an AutoTask Button from Toolbar 
This procedure provides instructions for removing an AutoTask button from your 
toolbar. 

To remove an AutoTask button from the toolbar: 

1. Right click the button you want to remove and choose Customize. 

2. With the Customize window open, drag the toolbar button off the toolbar. 

3. Click Close.
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13. Appendix C: RPMS Troubleshooting Checklist 
Please obtain the following information when receiving an RPMS-related trouble call: 

1. Enter the details in the Additional Information field on the RPMS details screen. 
This information is in addition to the fields on the RPMS Detail Screen. 

2. Enter the package name including Menu Option used. 

3. Enter the Error Trap Report including Variable List. 

4. Include the Screen Capture of the error with private patient info blocked 
(demographics). Save the file and attach it to the ticket. 

5. Note whether the error occurred on a Production System or Test System. 

6. Note whether there are any outside contractors working on the system that are not 
officially contracted with OIT(such as Alternative Third Party Billing and Point 
of Sale software)? 

7. Note whether there are any non RPMS COTs packages being used, interfaced, or 
tested 
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